DESKTOP AND LAPTOP EDITION

USER MANUAL v4.1

DESKTOP AND LAPTOP EDITION

Table of Contents

______________________________________________________________________________

1. Introduction ...........................................................................................2
Overview ............................................................................................................................................... 2
System Requirements .......................................................................................................................... 3

2. Installation .............................................................................................4
The Setup Wizard ................................................................................................................................. 4

3. Backup Client ........................................................................................7
How to Backup ........................................................................................................................................ 9
Selecting Files for Backup .................................................................................................................... 9
Filters .................................................................................................................................................... 9
Manual Backups ................................................................................................................................. 10
Automatic Backups ............................................................................................................................. 10
Backup Resume ................................................................................................................................. 10
How to Restore...................................................................................................................................... 11
How to restore files and folders .......................................................................................................... 11
Finding Files ....................................................................................................................................... 12
Options and Settings ............................................................................................................................ 13
Account and Security.......................................................................................................................... 13
Connections ........................................................................................................................................ 13
Disk Usage ......................................................................................................................................... 14
Performance and Limits...................................................................................................................... 14
Advanced Options .............................................................................................................................. 15
Additional Settings ............................................................................................................................... 16
Volume Shadow Copy Service ........................................................................................................... 16
Outlook PST files ................................................................................................................................ 16
SnapShot Backup and Restore .......................................................................................................... 17
Dynamic Profiling................................................................................................................................ 17
Change Look & Feel ........................................................................................................................... 17
Backup on Shutdown.......................................................................................................................... 17

4. Security................................................................................................18
Blowfish Encryption ............................................................................................................................ 18
SSL Communication ........................................................................................................................... 18

A5_BP_DL_UM_WIN-26JUL05-HJ-R1. Attix5 Backup Professional Desktop and Laptop Edition v4.1 Copyright © 2005 Attix5. All rights reserved

1

DESKTOP AND LAPTOP EDITION

1. Introduction

______________________________________________________________________________
Congratulations on choosing Attix5 Critical Data Storage. We believe you will find Backup
Professional to be the most secure, scalable and efficient solution in addressing the business
risk associated with the protection of critical data in a distributed environment. If you experience
any difficulty during the installation of Backup Professional, please contact your software
provider.
Backup Professional Desktop and Laptop Edition (DL) is a remote storage solution that utilises
client/server architecture to securely replicate data from the client device to a central data
server. Data is compressed to minimise bandwidth utilisation and transferred using a secure
SSL connection to the server. The data is stored in an encrypted format, using an encryption
key known only to you.
Attix5 Backup Professional minimises risk, maximises productivity and allows businesses to
regain control of their most valuable asset – their data.
OVERVIEW

Backup Professional Desktop and Laptop Edition manages the backup and retrieval of files
and/or folders on your computer. Selected files are backed up to the Storage Platform that is
installed on a remote server. This is shown in the following diagram:

Your Backup Client connects to a group on the Storage Platform during the installation. The
Group Administrator oversees all group members, using the Backup Monitor. The Storage
Platform administrator uses the Storage Platform Console to manage the entire Storage
Platform, including all the different groups.
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SYSTEM REQUIREMENTS

Operating System

Microsoft Windows XP Professional and Home

Microsoft Windows 2000 Professional

Microsoft Windows Millennium Edition (ME)

Microsoft Windows 98 Second Edition
Processor

Required: Pentium processor

Recommended: Pentium III-500Mhz for more than 500 documents
Memory
Memory requirements mainly depend on the amount of files selected for backup.

Required: 128MB RAM above operating system and application requirements

Recommended: 256MB RAM above operating system and application requirements
Disk Space

Required: 50MB plus space for local cache.

Recommended: Amount of free space equal to the backup account limit. The local cache
can be as large as the total size of all files selected for backup; a file selection of 100MB
needs up to 100MB extra disk space for the cache.
Minimum Video Settings

800 x 600 Resolution, 256 colours
Other Hardware

Network interface card or a virtual network adapter card

CD-ROM drive or Internet access to download and install the software
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2. Installation

______________________________________________________________________________

To install the Backup Professional Desktop & Laptop software, simply run the software
installation file, provided to you by your backup administrator.
You have the option to decide whether you would like the
Installer to create a shortcut on the desktop, place a copy in
the Startup and if the Backup Client should run after the
installation process has been completed. At the bottom of the
window, Install to enables you to change the installation path.
The default path is C:\Program Files\Attix5 Backup
Professional.
Click on Install to continue. The Installer will extract the files
and install the Backup Client. When the installation is
complete, the message “Attix5 Backup Professional has been
installed successfully and will now load. Click on OK to continue.” will be displayed. Click OK.
When you open the Backup Client for the first time, the Setup Wizard will start automatically.
You need to create an account for the Client on the Storage Platform before you can initiate any
backups.
THE SETUP WIZARD

Step 1 of 8 (Optional)
This step will only be displayed if these settings
were not included when your backup administrator
created the deployment file. The Backup server
address is the IP address or host name of the
NameServer that authenticates you before you
can backup or retrieve data. The Group name
specifies which group you will join and the Group
create key is needed in order for the client to
create an account in the specific group.
Note: Ensure that you enter the correct
settings. Contact your backup administrator if
you are not sure about the settings.
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Step 2 of 8
If you are installing the backup software for the
first time, select “I want to create a new backup
account”. If you have an existing account that
you want to reconnect to, select the "I want to
reconnect to an existing backup account"
option. Click Next to continue.
Note: You cannot connect from different
computers to the same backup account. Each
computer must have a separate account.
Step 3 of 8
Choose and enter your backup username,
password and encryption key. The backup
username and password can consist of any
keyboard combination between 4 and 20
characters. The encryption key can be any
keyboard combination between 8 and 56
characters. Click Next.
Note: Do not forget your encryption key as you
will not be able to retrieve your data without
this encryption key.
Step 4 of 8 (Optional)
This step will only appear if your Backup
Administrator enabled this feature when the
deployment file was created. These fields are
mandatory and you have to complete them before
you will be able to continue. Click Next.

Step 5 of 8
Select the connection that you want to use to
connect to the Storage Platform.
Use the Configure Proxy button to specify any
Proxy settings needed for communications to the
Internet. Click Next to continue.
If you select the modem/dialup connection, the
next step will prompt you to supply the connection
that you want to use.
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Step 6 of 8
This step will only appear if you selected the “modem/dial-up connection” option in Step 5.
Select the dial-up connection that you use to connect to the Internet and enter the dialup
username and password. Click Next.
Step 7 of 8
In this step you can configure the backup
schedule. The default backup time is 19h00. It is
advised to backup at night when the computer is
not in use. The computer (and the modem if you
are using a dial-up connection) must be switched
on at the time of scheduled backups. With
Skipped backups the Backup Client can notify
you if you missed any scheduled backups. Click
Next.
Note: If you do not schedule any backups, you
have to manually backup your data. We
strongly recommend that you run automated
backups.
Step 8 of 8
Confirm that the information you supplied is
correct, and click Next. The Backup Client will
connect to the Storage Platform and configure
your account. A message will be displayed to
confirm that your account was created
successfully.
Click OK to close the message box.
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3. Backup Client

______________________________________________________________________________
Backup Professional Desktop and Laptop Edition keeps your most valued data secure. It allows
you to select files and initiate backups, and to restore lost or corrupted files. You can also find
and restore files from previous backups and schedule automatic backups.

While you are using the Backup Client, you may select Help from the Help menu, should you
require any help. This additional windowpane on the right of the window above, will guide you
through the operation of the Backup Client. For an up-to-date version of this user manual,
please visit http://www.attix5.com/onlinehelp/dl.
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If you open the Backup Client you will notice a new icon in the system tray. The
A5 Runner
must be running to initiate scheduled backups. If you move the mouse pointer over the icon, it
will display the next scheduled backup time. After you have selected files for backup, you can
close the Backup Client. The A5Runner will stay active in the system tray and initiate any
scheduled backups, which will backup your selected data to the Storage Platform.
If you right-click on the A5 Runner you will see the following options:
Open Attix5 Backup
Professional DL

To open the Backup Professional Client to modify your file selection
initiate backups, restore files and configure the backup schedule.
You can also open the Backup Client by double-clicking on the icon.

Backup Now

With this option you can manually initiate a backup without having to
open Backup Client first.

Quit

To close the DL Runner. Note: This will stop all automatic
backups.

If the Backup Professional Client is open but another program is active, you can right-click on
the A5 Runner and click on Show Attix5 Backup Professional DL, or simply double-click on
the icon. This will bring the Backup Client to the front.
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How to Backup
The next sections describe how to select files and folders for backup, how to add filters to
folders to automate the file selection of certain file types, and how to backup your files to the
Storage Platform.
SELECTING FILES FOR BACKUP

To select files that you would like to backup, click on the
Backup Selection tab. The folder
structure of your computer is displayed in the left-hand pane. If you click on a folder, its
contents will be displayed in the right-hand pane. Subfolders are only shown in the left-hand
pane. Once a file or folder is selected for backup any changes, additions or deletions to that file
or folder are automatically backed up.
To select an individual file: Browse to the individual file that you would like to backup. In the
right-hand pane, right-click on the file and choose Select or click in the box next to the file. A
selected file is displayed with a green icon. To deselect a file you can either click on the box
again or right-click on the file and Deselect it. Folders that have some files selected are
displayed with a
green tint.
To select an entire folder: Right-click on the
folder and select Include Folder. You can
also use the left mouse button to highlight the folder and then Include the folder from the
Selection menu. Included folders are displayed with a
green folder. All files in the included
folder and its subfolders are now selected for backup. Any changes made within this folder or
its subfolders will automatically be included as well. To deselect a folder, right-click on the folder
name and select Deselect Folder from the selection list.
To exclude a file or folder: If an entire folder is included but you want to exclude a particular
file or subfolder, right-click on the file or folder and select Exclude. Excluded items are
displayed with
red icons or
red folders. Folders that have been selected but have some
files or subfolders excluded are green with a red
tint.
To verify the size of your backup, select Calculate Size from the File menu or click on the Size
button in the toolbar. If your backup set is larger than your allocated limit you have to reduce the
size of your selection. To remove files, right-click on a file that you want to exclude and click on
Deselect. Alternatively, you can ask your backup administrator to upgrade your account limit.
If you do not want to wait for the next automated backup, you can select Backup Now from the
File menu to manually start the backup process.
FILTERS

You can use a filter to automate the file selection of particular file types from a specific folder
and its subfolders. For example, a *.doc filter will include all existing Word documents, as well
as any new Word documents that may be added later. To add a filter to a specific folder, rightclick on the folder, select filters and choose one of the available filters from the list.
A few filters have been provided for you to start with. You can create, modify and delete any of
the filters. To modify a filter, select Filters from the Selection menu and click on Edit filters.
Select one of the filters and Add or Remove any of the file types. The New filter option allows
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you to add additional filters. Supply a name that describes the filter and then enter the file
type(s).
Example: AutoCAD users may want to only select their drawing files as the rest are generated
by AutoCAD and do not need to be backed up. The filter could be called Drawings and the filter
type would be *.dwg.
Files and folders that are included by applying a filter are displayed with blue icons and blue
folders. You can exclude particular filtered files or folders by right-clicking on the file or folder
and then selecting Exclude. A filtered folder with exclusions is displayed with a red
tint.
More than one filter can be applied to a specific folder. To remove filters from a folder, rightclick on the folder, select Filters and clear the checkbox next to the specific filter(s) that you
want to remove.
MANUAL BACKUPS

After you have selected the files and folders for backup, you can manually initiate the backup
process by selecting Backup Now from the File menu or by clicking on the Backup button in
the toolbar. You may close the Backup Client after you have started the backup process by
clicking Hide. This will not cancel the backup process and you can at any stage open the
Backup Client to view the progress of the backup. Backup log information can be viewed in the
Logs tab. Backup entries are displayed in blue.
AUTOMATIC BACKUPS

The Backup Client can be scheduled to backup your selected files and folders automatically.
Note that if you configure the Backup Client to backup at night, the computer must be powered,
and you have to be logged in. The backup schedule can be changed by selecting Automatic
Backups from the Tools Menu or by clicking on the Automate button in the toolbar. Backup
logs can be viewed in the Logs tab. Backup entries are marked in blue.
Automatic Backups that are scheduled between 19h00 and 07h00 will start at the scheduled
time but the Backup Client will randomly select a time between the start time and 07h00 to
transfer your data to the Storage Platform. This reduces traffic peaks on the servers and makes
it impossible for a third party to anticipate the exact time when your data will be transferred to
the Storage Platform. Automatic Backups scheduled during daytime will start at the scheduled
time and immediately transfer your data to the server.
Note: You are advised not to disable automatic backups as you will then have to
manually backup your files.
BACKUP RESUME

The Backup Client can try to resume a backup, if the previous request failed for whatever
reason. If you select Backup Now from the File menu or you click on the Backup button in the
toolbar and the previous backup was not successful, the Backup Client will prompt “Do you
want to resume the failed backup?” If you select Yes, the Backup Client will try to continue
from where the process failed during the previous backup. Select No to initiate a new backup or
Cancel to return to the Backup Client.
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How to Restore
The next section describes how to select the files that you want to restore, how to search for
specific backed up files, and finally how to restore files from the Storage Platform.
HOW TO RESTORE FILES AND FOLDERS

Open the
Restore tab. From this tab, you can gain access to your backed up files. Your
latest backup is shown in the Last Backup folder. If you expand the Previous Backups folder,
the Backup Client will connect to the Storage Platform and retrieve a list of all previous backup
dates.
Select the files and/or folders you want to restore. To select a single file, right-click on the file
and click on Select or you can click in the box next to the file. To select an entire folder, rightclick on the folder and then choose Select folder. Selected files are displayed with
green
icons. To start the restore process, select Restore from the File menu or click on the Restore
button in the toolbar. Note: Automatic backups are disabled during the restore process.
The Backup Client will prompt for a restore location to where the file(s) must be restored. If you
select Original location, the files will automatically be restored to the same location from where
they were backed up.
Note: If you choose this option, the restored files will overwrite any existing files with the
same name in that location. You will be warned before the Backup Client overwrites any
files.
If you do not want to overwrite the current copy of these files, select the Folder option. The
default path is C:\Program Files\Attix5 Backup Professional\Restore. You can also Browse to
another folder if you want to restore the files to a different location.
Restore Options:
Recreate directory
structure

By default, the folder structure is recreated in the restore folder. If
you want all files to be restored to one location, uncheck the
Recreate folder structure option. Note: If you are restoring files
from different folders with the same filename, you must recreate
the folder structure or they will overwrite each other.
Overwrite files
Enable this option if you do not want the Backup Client to prompt you
before overwriting an existing file.
Use
compression Tick the Use compression option to enable compression. With this
(faster
over
the setting enabled, the Storage Platform will compress the files before
Internet)
transferring them to the Backup Client. Note: You are advised to
always enable this setting if you have a slow connection to the
Internet as the files are smaller with this option enabled.
Restore log information can be viewed in the Logs tab. Restore entries are displayed in green.
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FINDING FILES

The Find files in Backups option enables you to search through your previous backups to find
a specific file. You have the option to do a local search from your last backup, or you can
connect to the Storage Platform to search through your previous backups.
To search for a file from your latest backup, select Find files in backups from the File menu or
click on the Find button in the toolbar. Enter the filename in the textbox and click on Find.
Example: If you enter help in the textbox, the Backup Client will display a list of all backed up
files from your last backup that contain help in either the filename or the folder.
Note: You can use the * and ? wildcards for advanced search queries to find the files that
you are looking for.

To search for files from previous backup sets, enable the Search through previous backups
on server checkbox.
File dates can also be specified and you can and limit the number of results that must be
displayed. Note: The Backup Date is used if you enable Search file dates and not the file
create or file modified dates.
To restore the located files, select them individually and then click on the Restore button.
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Options and Settings
From this Tools menu option you can view and configure the primary Backup Client options and
settings. To open this section, select Options… from the Tools menu. The various options and
settings are grouped according to their functions and displayed in different tabs.
Note: Please read through this section carefully before you change any of these settings.
Incorrect settings could cause serious problems or even stop the Backup Client from
backing up your data.
ACCOUNT AND SECURITY

Account Information
This section displays your backup account information as it is stored in the Storage Platform.
You can use the Update Limit button to update your account limit from the Storage Platform.
This tool is useful to verify that your account limit has been modified after requesting a change
from your Backup Administrator.
Account Setup
If you need to change your password or encryption key, select either the Change Password or
Change Encryption Key buttons. Changing your encryption key involves intensive processing
on the Storage Platform and may take several minutes. It should therefore not be done unless
your encryption key was compromised.
Security Settings
The Security window allows you to select whether the Backup Client should remember the
backup account password when running a backup or a restore. There are three options
available:




Remember password for backup and restore: The Backup Client remembers the user
password when doing a backup or restore. This is the default setting.
Prompt for password on restore: The Backup Client prompts for the user password
during the restore process.
Prompt for password on backup and restore: The Backup Client prompts for the user
password during a backup or restore process. Automatic backups are not possible with
this setting.

CONNECTIONS

Connection Settings
In this section, you can change the connection that the Backup Client must use to connect to the
Storage Platform. You can choose between a network/permanent or dial-up connection.
The Dial-up Settings button is enabled if you select the Dial-up option. Click on this button to
select an existing dial-up connection configured on the computer, and supply the username and
password for that Internet connection.
Proxy Server
Enable the Use a proxy server for you network or dial-up connection checkbox if you
connect to the Internet via a proxy server, and supply the necessary information.
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DISK USAGE

Working Folders
If you have limited space on the drive where the
Backup Client is installed, you can move the
Cache, Logs and Temporary folder to another
drive. The Temp folder is used for temporary
workspace when the files are patched,
compressed and encrypted, the Logs folder
stores all backup and restore logs, and the
Cache folder keeps a local, compressed and
encrypted, copy of the selected files for a
specified amount of days.
Note: Always keep these folders on the same
drive. If you move these folders to a network
share, please ensure that the Backup Client
has the correct permissions to reconnect to
that share.
Cache
When modifications are made to a file, the Backup Client only transmits the changes to that file,
as opposed to transmitting the complete file again. This is accomplished by keeping a
compressed copy of the file in a local cache and then using a sophisticated patching technique
to extract the difference between the file in the cache and the one ready to be backed up.
Files are only kept in the cache for a certain amount of days. . Files are added to the Cache
folder if the file was modified within the Days to keep files in Cache window. Once a file has
been flushed from the cache, a full copy must be backed up when any modifications are made
to the file. The longer files are kept in the cache, the better the chance of only transmitting
patches instead of full copies and thus reducing the amount of data that needs to be transmitted.
If you have limited disk space, you may want to consider shortening the time files are kept in the
cache.
Note: If you select 0 days, patching is disabled, any files in the Cache folder will be
deleted, and complete files are backed up to the server during each backup.
To delete the current cache, use the Clear Cache… button. If you delete the cache, full copies
of your selected files will be re-sent to the server during the next backup. You may notice that
the Backup Client will log the message Doing monthly cache cleanup once a month. This
maintenance task is to ensure that the cache folder is up to date by deleting any files that fall
outside the Days to keep files in Cache window.
PERFORMANCE AND LIMITS

Processor Usage and Disk Access
The Backup Client uses a fair portion of the available processor power to patch, compress and
encrypt files while during the backup process. If you use the computer at the same time, you
may experience some performance deterioration. You can lessen this effect by lowering the
Processor Usage.
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Disk Access is another setting that you can modify to limit performance deterioration. If this
setting is set to high, the Backup Client will continuously use all available disk access to write to
the disk, ensuring that the process completes as fast as possible. The process will take longer if
you lower this setting but your other applications will still function without any interruptions.
Limits
Outgoing transfer limit - The outgoing transfer bandwidth can be limited (in kBytes/second) in
case you need to allocate only a certain amount of bandwidth to the Backup Client.
Backup size restriction - You can limit the total amount of data that may be transferred during
each backup. Note: If you enable this option, it may take several backups before all your files
are backed up to the Storage Platform. This feature is especially useful if you have a poor
Internet connection and you encounter problems with transferring large backups.
ADVANCED OPTIONS

Options and Retries
The Backup Client can be configured to Always connect to the Storage Platform during each
backup to update its last backup date stamp, even if there were no changes made to the backup
set. With this setting enabled, the Storage Platform will always be up to date with the latest
backup date.
Enable Volume Shadow Copying to backup locked files enables you to backup locked files
without using third party open file management software. This is currently only available on
Windows XP and Windows 2003 Server Operating Systems.
Number of Backup/Restore attempts before cancelling - By default, the Backup Client tries
to connect to the Storage Platform four times before cancelling the backup process. If you have
a poor connection to the Internet, you may want to consider increasing the number of attempts.
The backup will continue from the previous point of failure. It will not resend the entire backup.
Connection Retries - By default, the Backup Client will try to reconnect to the Storage Platform
after 60 seconds, should the connection be dropped. This setting enables you to increase/
decrease the duration between the retries.
Socket Timeout - The socket timeout is, by default, 120 seconds. If the Backup Client is
connected to the Storage Platform and there is no communications between the two, this
amount (in seconds) is the duration that the Backup Client will stay connected before dropping
the connection.
Logging Level
You can specify the level of information that must be included in the log files. Choose between:
 Log all messages
 Suppress detail messages
 Log errors and warnings

A5_BP_DL_UM_WIN-26JUL05-HJ-R1. Attix5 Backup Professional Desktop and Laptop Edition v4.1 Copyright © 2005 Attix5. All rights reserved

15

DESKTOP AND LAPTOP EDITION

Additional Settings
The Tools menu provides you with various options and settings that you can modify to enhance
and streamline your Backup Client. You can also modify your account settings from this menu.
VOLUME SHADOW COPY SERVICE

Applications often keep their data files locked if the application is running. This is usually a
problem when trying to backup these files as the application does not allow the backup agent
access to the file to determine the changes since the last backup.
Microsoft Volume Shadow Copy Service (VSS) provides a solution by automatically creating a
snapshot of the data at any given point in time without any interruption to the application, and
without the need for any third party software.
VSS is currently available on Windows XP and Windows 2003 Server operating systems and
enabled by default in the Desktop and Laptop Edition backup client, if the client is installed on
Windows XP. If you would like to disable VSS, select Options… from the Tools menu and then
the Advanced Options tab. Disable VSS by removing the check in the checkbox next to
Enable Volume Shadow Copying to backup locked files.
Note: VSS enables you to backup e.g. your Outlook PST files without having to close
Outlook.
OUTLOOK PST FILES

Note: You do not have to use the Outlook
plug-in if you are using Windows XP; the
PST file can be backed up using VSS. The
Outlook plug-in will automatically be
disabled if VSS is available.
If you include any Microsoft Outlook PST files
in your backup selection you can enable the Backup Client to close and restart Outlook during
the backup process. PST files are locked if Outlook is open so the Backup Client will skip this
file as it cannot access the file to determine the changes since the previous backup. Note:
Outlook will only be closed if you have a PST file selected and it will not close Outlook if
there are any unsaved emails open.
To enable these settings select Plugins from the Tools menu and then click on Outlook.
Enable the options that you want and click on OK to save the settings.
You will be prompted whether you want to save any unsaved e-mail messages during the
backup process. A 30 second delay has been implemented so that you can save these
messages and close Outlook. If you do not close Outlook within this time, the backup process
will continue and the file will be skipped.
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SNAPSHOT BACKUP AND RESTORE

SnapShot Backup and Restore enables you to create a backup of your selected files on a local
SnapShot server within your Local Area Network (LAN). This SnapShot server will then be
physically moved to the server running the Storage Platform where the data will be transferred.
The Storage Platform is usually hosted at a Data Centre off site and this feature enables the
backup administrator to reduce the initial backup window if there is a large amount of data that
must be backed up.
A similar procedure can be followed when restoring a large amount of data, for example, during
a Disaster Recovery.
Note: Only the backup administrator should change these settings. Instructions for using
this feature can be found in the Backup Professional Storage Platform Manual.
DYNAMIC PROFILING

Dynamic Profiling enables your Backup Administrator to propagate certain client side settings
from the Storage Platform to your Backup Client. Note: These settings take priority over any
settings specified in the Backup Client. These settings include:

Changing the backup schedule

Specifying system file exclusions

Adding additional filters to the filter list
When the Backup Client connects to the Storage Platform, it will receive a list of any Dynamic
Profiling settings specified by the Backup Administrator and these changes will be implemented
in the Backup Client. If you modify any of these settings with Dynamic Profiling enabled, it will
revert back to the Dynamic Profiling settings during each backup.
CHANGE LOOK & FEEL

You have the option to change the look and feel of the Backup Client. From the Tools Menu, go
to Change look & feel and select one of the available options.
BACKUP ON SHUTDOWN

Backup Professional can automatically initiate a backup when a user restarts or shut down the
computer. This feature is enabled by the backup administrator and cannot be modified from the
Backup Client.
When you initiate a Shut Down or Restart your computer, a dialogue box will prompt Do you
want to backup now? Click Yes to backup or No to continue with the shut down process. A
progress window will display the backup process on screen. After the completion of the backup
a message Windows is shutting down. Click button to restart will be displayed with a timer
counting down from 10 seconds. Click on the button to restart the machine or wait for the
machine to shut down. Note: The backup administrator can configure Backup on
Shutdown to be initiated without any user intervention from the client side.
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4. Security

______________________________________________________________________________
Attix5 Backup Professional uses a combination of Blowfish encryption and SSL secure data
transmission to ensure the safety of your data.
When the Backup Client has to transfer data to the Storage Platform, it connects using a secure
SSL (1024 bit RSA key exchange, 128 bit RCA stream cipher and SHA-1 integrity checking)
connection to transfer the data. Signed SSL certificates and Certificate Revocation Lists (CRLs)
are used to verify server integrity.
Data is stored using 448-bit Blowfish encryption to encode the data on the Server. This is
considerably greater than the encryption used for Internet banking and online credit card
transactions.
Your encryption key is seen as a passphrase by the Storage Platform. A random encryption key
is automatically generated when any account is created and this random key (and not the
passphrase specified by you) is used to encrypt your files.
The encryption key is protected by the passphrase (your encryption key) and without this
passphrase you cannot decode the actual encryption key. When you change the encryption key
in the Backup Client, the actual key is decrypted and re-encrypted with the new passphrase.
The data is never touched. All data since the initial backup is encrypted with the same random
encryption key even when the passphrase is changed. If you change your encryption key, you
do not have to remember the previous encryption keys for future restores – the Backup Client
will be able to retrieve the data from the Storage Platform.
Your encryption key is not stored anywhere on the Storage Platform, and is only known
to you. If you forget this encryption key, it will render your data unrecoverable.
Security standards and techniques employed by Attix5 Backup Professional are audited by
PricewaterhouseCoopers to ensure that sensitive corporate data remains safe from prying
eyes when transferred over the Internet or stored on a server.
BLOWFISH ENCRYPTION

Blowfish is an encryption algorithm. It is a symmetric block cipher, which uses a variable-length
key from 32 bits to 448 bits. Backup Professional uses the maximum strength 448-bit key.
SSL COMMUNICATION

The Secure Sockets Layer (SSL) is a commonly used protocol for managing the security of data
transmission. Attix5 Backup Professional makes use of the SSL protocol (1024 bit RSA key
exchange, 128 bit RC5 stream cipher and SHA-1 integrity checking) for secure communication
between the Backup Clients and the Storage Platform, including data transmission.
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